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Overview

1. Estimated time required to complete

Between 1 and 2 hours.
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2. Responses to submit on Canvas

Your article's cognitive skill

Item 1:

Is the brain region that you named in your answer to
Part 1, question 2.B.iii.b part of the Neurosynth brain map?

Jump to Item 1 instructions

Item 2:

Screenshot of the brain region from Item 1

Jump to Item 2 instructions

Item 3:

Paste the table that lists the first 10 Neurosynth "Associations"
for the brain region from Item 1

Jump to Item 3 instructions

Item 4:

Based on the names of the associated Neurosynth meta-analyses,
what one other cognitive skill do you think your brain region might be
involved in?

Jump to Item 4 instructions

Comparing your article's cognitive skill with another skill

Item 5:

Screenshot of the 3D surface model, with blobs from both Neurosynth maps
revealed by the "cut planes".
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Jump to Item 5 instructions

Item 6:

Screenshot of one ROI cluster from the intersection of
both Neurosynth maps

Jump to Item 6 instructions

Item 7:

Where in the brain is this cluster, and why did you choose it?

Jump to Item 7 instructions

Item 8:

Paste the table that lists the first 10 Neurosynth "Associations"
for this cluster's coordinates

Jump to Item 8 instructions

Item 9:

What do you think this cluster's brain region does?

Jump to Item 9 instructions

Questions about this activity

Item 10:

What was confusing about this assignment, or what questions did it
bring to mind that you would like to understand about neuroimaging or meta-
analsis?

(This question does not appear elsewhere in the instructions, only right here.)
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Item 11:

What would be another interesting thing to do with Mango and/or Neurosynth
for this assignment? Is there anything you would like to do,
even if you're not sure whether it's possible to do with these tools?

(This question does not appear elsewhere in the instructions, only right here.)

Get ready to neuroimage!

1. Install Mango software

You will need to install the Mango viewer software to do this part of the assignment. In general, I prefer
not to ask students to download software, but currently there are no browser-based MRI image viewers
available online that provide all the features we need. I have chosen Mango to download because it is
non-commercial (so that there are no ads or additional software that come with it), free1), and designed
to work with all major operating systems.

http://ric.uthscsa.edu/mango/mango.html

Click on the link for your operating system, and follow the prompts. The website includes some
instructions too.

Mango download page

http://ric.uthscsa.edu/mango/mango.html
https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:mango_download.png
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2. Download a file to use with Mango

As you know, functional MRI (fMRI) measures differences in blood oxygenation levels. For technical
reasons, fMRI images usually need to be relatively low-resolution (they look blurry). Also, the goal of most
fMRI studies is to identify small, specific regions of the brain that are associated with a cognitive task.
The final results of most fMRI studies (which are usually called “activation maps”) don't look like a picture
of a whole brain, or even of a recognizeable part of a brain. They just depict little three-dimensional blobs
that mark the location of the brain regions most highly associated with the cognitive task from the study.
So, the blobs that are visible in an fMRI activation map are like the Xs that “mark the spot,” but without
the underlying treasure map! Looking at activation maps on their own is like looking at a blank piece of
paper with an X on it – it tells you that there is, in fact, a treasure/important brain region, but not where
to find it.

To understand which locations the activation blobs (the “Xs” in the treasure map analogy) mark in the
brain, we need to “put the map under the Xs.” In our case, the “map” is an image of a whole brain (in 3D
of course). The image that we will use is a composite image based on averaging together the structural
MRI images of 152 individual brains. (Structural MRI images are high-resolution images that look more
like a photograph than functional MRI images, and they don't measure blood oxygenation.) This average
image is a little too smooth around the edges to look like a real, single person's brain, but that's the
point: we want to understand where an activation blob would be located on average, in anyone's brain.

So, please download a file available in this Canvas folder:

https://canvas.vt.edu/courses/57758/files/folder/writing_assignment/brain

File name: mni_icbm152_t1_tal_nlin_asym_09a_acMasked.nii.gz

(NOTE: If your computer asks you to unzip this (or do anything else) with this file, respond “No.” The only
reason this file is zipped (compressed to reduce the size of the file) is to make it easier to download and
save. Mango will read this file without you having to unzip it first.)

Make a note of where the downloaded file gets saved, so that you can open it later. You can ask your web
browser to show you where the file was saved in a number of ways, including:

In Firefox: Under the “Tools” menu, select “Downloads.”
In Chrome: Under the “Window” menu, select “Downloads.”

This file is a version of the standard 152-person average brain created by the Montreal Neurological
Institute (MNI) in Canada. You will see this abbreviation a few times during this activity, because the MNI
originated a number of widespread neuroimaging techniques. The only difference between this version of
the file and the standard version available online from the MNI is that your instructor has removed the
face, skull and other non-brain portions of the image, so that it will look more like a brain when we
eventually view a 3D rendering of it.

https://canvas.vt.edu/courses/57758/files/folder/writing_assignment/brain
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3. View the structural average brain in Mango

Now that we have …

The Mango viewing software1.
A copy of the structural average brain file2.

… we can look at the average brain.

3.1 Start the Mango app

I feel funny writing instructions to you youngsters about how to open apps, because you know, you're
more familiar with “apps” than me. However, problems can occur, and please don't hesitate to ask if they
do.

3.2 Open the structural average brain file: the "image"

Somewhat confusingly, Mango uses different words when it refers to 1) the structural brain image, and 2)
the functional activation map image. To me, these both count as “brain images.” However, Mango calls
the structural brain file an “image,” and it refers to functional activation maps as “overlays.” This is
only important because there are different menu commands for the two kids of files.

To load the average structural brain image, use the mouse menus to select “Open image,” as seen here:
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Load the average structural brain image using the “Open image” command

Select the file that you downloaded from Canvas.

Congratulations! You made a brain appear! It should look like this:

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:mango_open_image.png
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This is what you should see in Mango after loading the average structural brain image.

3.3 Enable the atlas feature

Mango can show us the name of the brain region that is under the mouse, but we need to enable this
feature first. Mango looks up the most likely name for each brain region using a data set called an
“atlas.” Click on the button in the main Mango window (which is actually the smaller window) that looks
like a sphere, and then select “Atlas → MNI (Nearest Gray Matter)”.

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:mango_image_opened.png
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Enable the atlas feature

Technically, the names of the brain regions (the “atlas labels”) only describe regions of gray matter.
However, because our structural brain image is an average brain, it is very possible that some individual
people's brains will have gray matter in locations that correspond to white matter in the average brain. A
consequence of this is that functional activation blobs can sometimes appear to be located in white
matter on the average brain. In those cases, we still want to know what to call that part of the brain.

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:mango_enable_atlas.png


Last update: 2020/03/26
13:06 teaching:writing_assignment_part_2 https://wiki.anthonycate.org/doku.php?id=teaching:writing_assignment_part_2

https://wiki.anthonycate.org/ Printed on 2026/03/07 04:23

Look in the main Mango window to see the name of the brain region located under the mouse pointer

Mango will display four different names with different levels of specificity. The one we want is the one at
the upper right of the atlas window, e.g. “Sup Temporal Gyr” for superior temporal gyrus.

HINT: if the atlas abbreviations are unclear, try Googling them.

Get brain maps from the Neurosynth website

1. Go to the Neurosynth homepage in your browser

http://neurosynth.org/

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:mango_atlas_enabled.png
http://neurosynth.org/
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2. Get a meta-analysis for your article's topic

Neurosynth provides a very interesting service: it allows us to view something like the most probable
functional activation map that we could expect from an fMRI study if all we knew about the study were its
keywords.

Because of this, the terms or keywords that we enter in Neurosynth can make a big difference in the
activation maps that we get back. In particular, the level of specificity of the terms can make a big
difference. For example, as we know from class, the English word “memory” refers to many different
cognitive processes, including many that probably rely on distinctly different brain regions. If we enter
the query “memory,” Neurosynth will return a map showing the likely locations of functional activation
across all published studies that featured the word “memory.” This will lump together “apples and
oranges” – distinctly different patterns of activity produced by qualitatively different cognitive processes
that happen to share the term “memory” in their names, like “episodic memory” and “working memory.”

2.1 Find the Neurosynth term to use for your article

Please use the term that corresponds to the article you reviewed for Part 1 of this assignment:

Neurosynth terms for each article from Part 1

General Topic Article Title Neurosynth term to
use

Perception Untangling invariant object recognition. Object recognition
Towards a neural basis of music perception. Music
What is specific to music processing? Insights from
congenital amusia. Musicians

Attention Why visual attention and awareness are different. Awareness
Moving towards solutions to some enduring
controversies in visual search Visual attention

Memory The neurobiology of semantic memory. Semantic memory
Working memory capacity and its relation to general
intelligence. Working memory

False memories and confabulation. Memory retrieval
The contribution of sleep to hippocampus-dependent
memory consolidation. Consolidation

Observing the transformation of experience into
memory. Memory encoding

Language Towards a functional neuroanatomy of speech
perception. Speech perception

Reflections on mirror neurons and speech perception. Mirror neuron

Decisions/Problems Neuroeconomics: cross-currents in research on
decision-making. Decision making

Cognitive and AI models of reasoning. Reasoning
Intelligence Genetics and general cognitive ability (g). Cognitive control
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General Topic Article Title Neurosynth term to
use

Evolution of the brain and intelligence. Intelligence
Consciousness Consciousness cannot be separated from function. Consciousness
Neurosynth terms
validated 2017-10-29 by
adc

2.2 View the meta-analysis for your term

Select the Meta-analyses → Terms menu

Type in your term and click the link that appears below

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:neurosynth_terms_menu.png
https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:neurosynth_terms_search.png
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Viola! You see before you the results of a neuroimaging meta-analysis.

2.3 Download the brain map image for your topic

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:neurosynth_term_thinking.png
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Click on the “download arrow” icon at the end of the “association test” line.

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:neurosynth_download_icon.png
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SAVE the file to a location that you can find later.

3. Get a meta-analysis for an "other" topic

Repeat the instructions for one of the “other topics” that you chose for your answer to Part 1, question
2.B.ii (“What is known about the relationship between this cognitive skill and two of the following general
cognitive skills?”).

Please use the following Neurosynth terms:

Neurosynth terms for each “other skill” from Part 1, question 2.B.ii

General cognitive skill Neurosynth term to use
Perceptual skills Perception
Selective attention Selective attention
Memory Memory
Mental imagery Imagery
Language Language comprehension
Intelligence or reasoning skills Intelligence
Neurosynth terms validated 2017-10-31 by adc

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:neurosynth_save_file_dialog.png
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Explore brain map images using the Mango
viewer

Follow the instructions above to open the average structural brain image and enable the atlas feature.

Again, the average structural brain image forms the background over which your functional activation
maps will be overlaid.

1. Examine the Neurosynth brain map for your article's
cognitive skill

Mango refers to functional brain maps as “overlays,” in contrast to the structural brain map, which is the
“image.” Mango can only open one “image” at a time, but it can have multiple overlays open
simultaneously.

Now we can open the first file that you downloaded from Neurosynth. DON'T use the first Mango
window's “Open” menu, even though that sounds like a good choice. Instead, use the “File” menu on the
viewing window that is displaying the structural brain image.

Use the File menu in the viewing window to open a functional activation map as an overlay.

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:mango_open_overlay.png
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If you get the warning shown in the figure below, just click “OK.”

You can ignore this warning and click OK.

With any luck, you will now see bright orange/red blobs superimposed atop the structural brain image.

NOTE: Mango (and most other neuroimaging software) cannot display the entire brain at once. Mango's
viewing window shows three different 2D views centered on the same crosshairs, but these three views
still can't reveal the entire 3D volume of the brain. This means that there can always be functional
activation blobs “hiding” somewhere just out of view.

If you don't see any orange/red activation blobs after loading your first overlay, try clicking and dragging
the mouse all around the brain, moving the blue crosshairs, until you've looked all over the entire brain.
There is almost certainly a blob there somewhere.

it is possible that your particular Neurosynth map might not have any activation blobs that happen to be
visible at the current view of the brain.

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:mango_bit_warning.png
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The display should look like this after adding the first functional activation map overlay.

Even if you are rewarded by seeing a brainful of orange/red activation blobs immediately after loading
your overlay, you should still click and drag the mouse around to explore the entire brain. You can do this
within any of the three different panes of the viewing window. Mango will keep all three panes in sync,
i.e. focused on the same point marked by the crosshairs.

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:mango_overlay_added.png
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Click on activation blobs to focus all 3 viewing panes.

1.1 Find the key brain region from your article

Refer to your answer to Part 1, question 2.B.iii.b (“Pick what you think is the most important of these
brain regions, and briefly state why you think it's the most important.”).

[If, and only if, your answer to question 2.B.iii.b was “my article didn't mention any brain regions,” then
skip ahead to the section entilted I HAD NO BRAIN REGION]

Does any of the Neurosynth brain map activation fall in this region?

For this assignment, we can answer the question using what we can call “the click/scroll/hover method.”

Find the part of the brain in question by clicking/scrolling around on the average structural brain1.
map, and then getting the proper atlas label to appear by hovering the mouse over the correct part
of the structural brain map. This will put you in the correct general area of the brain.

Get a good approximate sense of the boundaries of the region that corresponds to the atlas label,
by clicking/scrolling/hovering the mouse around until the atlas label changes.
Now you can judge whether any of the Neurosynth brain map activation regions (i.e. the colorful
blobs) fall in that region.

This is not a precise method, but it is more than good enough for our purposes. The small amount of
extra precision that we would get by using other methods would not be worth our time here. It is actually
quite tricky to name the brain regions covered by an activation blob. Just for starters, the boundaries of

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:mango_overlay_click.png
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brain regions are not always clear-cut, and even the names for various brain regions are not agreed upon
by all scientists. Then there is the whole issue of using an average structural brain to guide us, when
individual brains can be so different from each other.

Potential problems with finding a brain region

Here are two problems that we do need to address before going ahead with the click/scroll/hover
method.

Different names for the same brain region

“What if the atlas label names are different from the names that our review article used for brain
regions?”

Answer: You can trust your judgment and decide when you think the Mango atlas label is just another
name for the region mentioned in your article. More to the point, I (the instructor) will trust your
judgment, too. Just be sure to write down both names in your answer, for example:

“My article named the 'middle cingulate gyrus,' but Mango doesn't have an atlas label with that name.
Part of the Neurosynth activation map did overlap with the middle of the region that the atlas labeled
'Cingulate gyrus,' though. Therefore, my answer is yes, the middle cingulate gyrus does appear on the
Neurosynth activation map.”

I'm not a brain expert (yet)

“How do I find a brain region in Mango without clicking/scrolling/hovering over the whole dang brain? You
(the instructor) said I didn't need to know how to read MRIs.”

Answer: Try Googling the name of the brain region you're looking for. Try searching for images, if
necessary. Then use the results as a guide of where to look in Mango.

I HAD NO BRAIN REGION

Choose a blob of activation in your brain overlay, and figure out its name by hovering your mouse over it
(with the Mango atlas enabled). Then provide this name as your answer to Item 1, and use this region to
answer Items 2, 3, and 4.

Is the key brain region from your article part of the Neurosynth brain map?

Item 1:
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Is the brain region that you named in your answer to
Part 1, question 2.B.iii.b part of the Neurosynth brain map?
(This is a one-word answer: yes or no.)

[Or, if you had no brain region for question 2.B.iii.b:
Type the name of the brain region that you choose from your activation
overlay]

Take a screenshot of the region

Item 2:

Screenshot of the brain region from Item 1

Regardless of what your answer was for Item 1, take a screenshot of Mango when you have placed the
crosshairs on the region in question.

NOTE that the crosshairs are not the same thing as the mouse pointer; to place the crosshairs (the two
thin blue lines) you need to click the mouse.

PLEASE USE THE MANGO SCREENSHOT TOOL and not some other method for taking screenshots. Clicking
on the “camera” icon in the main (smaller) Mango window will save an image file to the same folder that
holds the average structural brain image file (i.e.
mni_icbm152_t1_tal_nlin_asym_09a_acMasked.nii).

Rename the file “[name of the key brain region].png” and upload it to Canvas. Examples of a good file
name: “SupTempGyr.png” or “Superior Temporal Gyrus.png”.

NOTE If your answer for Item 1 was “no,” then the crosshairs will mark an “unactivated” region of the
structural brain image. That is OK. You still need to upload the screenshot.

1.2 What other cognitive skills are associated with this region?

Copy down the MNI coordinates for the region

Copy down the stereotactic coordinates of the point in the brain marked by the crosshairs.

While the crosshairs are still marking the region, hover the mouse right on top of them. The reason for
moving the mouse is that by default, the main Mango window (the small one) displays the coordinates for
the location the mouse, and not for the crosshairs.

The 3D (or “stereotactic”) coordinates are given by 3 numbers (X,Y,Z), which appear in red font. The
fourth number that appears in white font to the right of them is not important for us here.

There are two main coordinate systems that scientists have developed for referring to locations in the
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average brain: Talairach coordinates, and MNI coordinates. The two systems are similar, but not identical.
The brain images that we are using (both the average structural brain and the Neurosynth functional
maps) are in MNI coordinates.

Enter the coordinates in a Neurosynth "locations" search

Click the “Locations” link at the top of any Neurosynth website page, or navigate your browser to this url:

http://neurosynth.org/locations/

Type the three numbers (including any minus signs) into the “Data for coordinates” fields, and press the
Enter key on your keyboard when you're done.

Type the X,Y,Z numbers into these three fields.

The web page will reload, showing a brain map with crosshairs and bright colors centered on the
coordinates that you entered.

http://neurosynth.org/locations/
https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:neurosynth_locations_enter.png
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We will not use the “Functional connectivity and coactivation maps” that appear, but here is a
brief explanation about them for those who might be interested. This color map represents something
different from the meta-analysis activation maps that you produced earlier. This time, the color map
indicates the probability that the location at these coordinates is “connected” with other locations in the
brain. I put “connected” in quotes because the color map is not based on measures of anatomical
connectivity, even thought those exist (e.g. diffusion tensor imaging maps of white matter pathways).
Neurosynths' “Functional connectivity and coactivation maps” display something like the probability that
other regions will be active in a functional MRI, given that the region under the crosshairs is active.

We will click on the “Association” link that appears above the brain map. The resulting web page gives a
table listing the names of other Neurosynth meta-analysis maps (that already exist, somewhere on the
Neurosynth web server) that have especially high values at the coordinates we entered.

https://wiki.anthonycate.org/lib/exe/detail.php?id=teaching%3Awriting_assignment_part_2&media=teaching:neurosynth_locations_maps.png
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Click the “Associations” link to see this list of terms associated with your coordinates.

We can use the names of these meta-analyses as a set of rough guesses about what other cognitive skills
might be associated with this brain location. Again, the activation maps from Neurosynth meta-analyses
are interesting because they represent pretty good answers to questions like, “If all I know about a
neuroimaging study is that the term X appeared in the article, which brain regions were likely to be
active?” Right now we are considering something like the reverse question: “If all I know about a
neuroimaging study is that coordinate X,Y,Z was active, what terms were likely to appear in the article?”
It requires an additional leap of faith to guess that just because an article included the term “language
comprehension” (for example), that our brain region is actively involved in producing that cognitive skill,
but it's a great start.

Copy the table from the "Associations" page and paste it at the bottom of your answer.

Item 3:

Paste the table that lists the first 10 Neurosynth "Associations"
for the brain region from Item 1

Again, this table should have only 10 rows.
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What else might this region do?

Item 4:

Based on the names of the associated Neurosynth meta-analyses,
what one other cognitive skill do you think your brain region might be
involved in?

Give the name of the skill1.
Explain why you concluded that.2.

By default, Neurosynth will display only 10 entries in this table, sorted in descending order by z-score.
That is enough. There is no need to examine or submit more than that.

Select the rows of the “Associations” table and copy the text.

In a few cases this will be a very straightforward answer to give. Many of the existing Neurosynth meta-
analyses are based on terms that describe methodological details or non-cognitive aspects of
neuroimaging studies, e.g. “dti” (for diffusion tensor imaging), “multivariate,” or “able” (too generic to be
a cognitive skill). It's possible that your coordinates will be associated with a list that includes only one
cognitive skill. In that case, you can just name it, and the only explanation you would need to give would
be “this was the only cognitive skill on the list.”

In most cases you will have to use your judgement to decide on the answer. For example, if not one but
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several different cognitive skills appear in the list, you will have to pick one. If several different skills all
have something in common (e.g. “language comprehension,” “speech production,” “syntax), the right
approach would be to give the name of that common topic as your answer (“language” seems good). For
your explanation, just state what you did to arrive at that decision.

A final possibility is that there won't be any cognitive skills on your list. In that case, the appropriate
answer is “none.” (You could examine more than the first 10 associations, but I just said that we don't
need to do that.) For your explanation, just state that none of the meta-analyses on the list corresponded
to a cognitive skill. (You will still need to copy and paste the table).

2. Compare the Neurosynth brain map for your "other" skill

2.1 Add your "other" brain image as a second overlay

Just to check in, this part of the instructions assumes that

Mango is running1.

The atlas feature is enabled
The Neurosynth functional map overlay for your article's cognitive skill is still open

Good. Now, open your second Neurosynth map (the one corresponding to your “other” cognitive skill).
Mango allows you to have multiple overlays open at once, and it will even automatically assign each one
a different color. The second one will be greenish.

Open your second Neurosynth map as an overlay.
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If you hate green, fear not. You can change any overlay's color (and tweak other things as well) by
clicking on the overlay icon in the main (smaller) Mango window. The icon at at the left of the row of icon
below the coordinates display, and looks like a little square with a color gradient. Clicking on the icon
once will a drop-down list with icons for both of your current overlays and an icon for the structural
“image” (in gray). Hovering the mouse over one of these icons will bring up a clickable menu.

The overlay menu expanded to show icons for the two overlays and the one structural “image.”

2.2 Make a 3D surface model
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Select Image → Build surface to make a 3D surface model

Click “OK” to accept the default options.
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Behold! A brain you can spin around by clicking and dragging with the mouse.

By default, only the first overlay that you opened will be visible on the 3D surface model. Add the second
overlay using the “Shapes” menu in the surface window.

Select “Shapes → Add Overlay” to add the second Neurosynth map overlay.

A dialog window will appear, asking you which overlay to add. Your second overlay (the green one)
should be listed by default, so click “Add.”
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Click “Add” to add your second overlay to the 3D surface model.

The only activation blobs that will be visible on the 3D surface model are those that actually extend all
the way to the outside of the average structural brain image. However, we can see any blobs we want by
enabling “cut planes” in the 3D surface window. A “cut plane” is a noun, short for “cutTING plane.” It is
like an invisible knife that cuts through the brain in one direction and removes all the brain stuff on the
side facing us, the viewers seated at our computers.

The “All Cut Planes” option sets up a set of three “cut planes” that intersect at the point marked by the
crosshairs.

Select “Surface → “All Cut Planes”

This is how the 3D surface model should look after selecting the “All Cut Planes” menu item.
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Congratulations! You now have a hole in your head.

The locations of the “cut planes” are linked to the crosshairs in the viewing window. To reveal different
parts of the 3D surface model's interior, click and drag the mouse around in the viewing window (and not
in the surface window).

The 3D surface model cut away to reveal the location marked by the crosshairs in the viewing window.

Take a screenshot of the 3D surface model

Item 5:

Screenshot of the 3D surface model, with blobs from both Neurosynth maps
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revealed by the "cut planes".

Move the “cut planes” around until you have revealed a nice view of the 3D surface model's interior, so
that blobs from both overlays are showing. That is, both orange/red and green/yellow blobs should be
visible.

Submit a screenshot of your awesome, holey brain by doing this:

Take a screenshot of the surface window.
Rename the file something similar to ”[name of main cognitive skill] and [name of “other” skill]
surface model.png”
Upload it to the appropriate place on Canvas.

*NOTE:* You must have the Mango surface window “highlighted” or “in focus” (by clicking on it) before
you use the main window's “camera” screenshot icon. Only the “highlighted” window's contents will be
saved to the screenshot.

It should look similar to this:

An example screenshot of the surface window's contents
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COMPLETELY NON-CREDIT OPTIONAL BONUS ACTIVITY:

You can explore the “Surface” menu to create a video of a spinning brain. The world is your oyster now.

2.3 Find brain regions activated by both cognitive skills

Scroll/click/hover around the brain to get a sense of how the Neurosynth activation map for your “other”
skill differs from the map for your primary cognitive skill. Think about the similarities and differences
between the two cognitive skills, and whether these are reflected by the degree to which their functional
maps overlap.

In most cases, the two maps will overlap in many places, but not always.

[WHAT IF MY TWO MAPS DON'T OVERLAP?]

[If your two maps really don't overlap, you will get messages saying things like “Zero components found”
for the following activities. This happens rarely, but there are some pairs of Neurosynth maps for this
assignment that do not overlap. If, and only if, this happens to you, you may type “my maps didn't
overlap” as your answers for Items 6, 7, 8, and 9. You won't be penalized.]

Now, let's do a more precise investigation of the locations where the two maps overlap. We can use
Mango to define a “region of interest” (ROI) that marks all of the overlapping locations.

In the Mango viewing window, select the “Analysis → Create Overlay Logicals” menu item.
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Select the “Create Overlay Logicals” menu item to make a third overlay.

This will open a “Create Logicals” dialog window. When Mango currently has two overlays open (as we do
now), it will list three possible ways for us to define a set of locations based on the locations covered in
the overlays. The first two ways are trivial: they just consist of selecting all the locations covered by one
of the overlays. The third way, even though it's not clearly explained in the dialog window, is to select all
the locations covered by both of our overlays; this is the one we want.

To make this work correctly, it is best to remove the first two rows in this list. Click on the “gear” icon to
the right of these rows and select “Remove this logical.”
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Remove the first two rows from the “Create Logicals” diaglog window.

Now, create a new overlay by clicking the “gear” icon to the right of the yellow square, and select
“Create ROI of region.”

Select “Create ROI of region”
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When this is done, you can close the “Create Logicals” window.

ROI stands for “Region of Interest” in neuroimaging. ROI is a vague term. It is mainly used when referring
to some set of locations that are smaller than the entire volume of the brain.

The new ROI will drawn on top of the structural brain image, although it can be hard to see. Right now it
will appear as a set of thin red lines that circumscribe the ROI's locations.

Instead of scrolling/clicking/hovering around to examine the hard-to-see ROI lines, we will ask Mango to
make us a nice table listing all the locations included in the ROI. Mango will helpfully group all of these
locations into several discrete “components” that consist of contiguous points. Mango uses the word
“component” to describe what most neuroimagers call “clusters.”

I prefer the word “clusters.” It is more tangible, and it makes me think of candy. When I use the word
“cluster” below, I am referring to the same thing as a Mango “component.”

In the Mango viewing window, select the “Analysis → Find ROI Components” menu item.
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Select “Find ROI Components” to generate a table of the ROI's locations.

This will open up the “Find ROI Components” dialog window:
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The “Find ROI Components” dialog window.

Click the “Find components” button. After message to the right of this button changes from “0
components found” to “[some number greater than zero] components found,” click on the “Create stats
of components” button in the “3. Component actions” section of the dialog window. You do not need to
adjust the number of components slider in section 2 of the dialog window.

This will open up a table in a window entitled “All Results.”

The ROI stats appear in the “All Results” window.
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The “All Results” window displays two different tables. At first, the “Global Statistics” table will probably
be visible. This is not the one we want. Click the “Point Statistics” button to switch to that view.

Switch to the “Point Statistics” table in the “All Results” window.

The “Point Statistic” table lets us do two helpful things:

First, it gives the name of the brain region where each cluster is located. That's right! No need to
scroll/click/hover2)! Simply read the names in the column titled “Atlas 3” to see a more or less complete
list of the brain regions that the ROI clusters occupy. The “Atlas 2” column names the larger structure
(usually a lobe of the cerebral cortex) that this region is part of. The “Atlas 1” column might look like it is
too general to be useful (as in, “Thanks a lot, Mango, I know that the frontal lobe is part of the cerebrum!
Sheesh. For real.”), but it is also specifies which hemisphere (left or right) the cluster is in. You could
figure that out by looking at the brain map, but sometimes it's easier just to read this from a table.

Second, the table is integrated with the Mango viewing window, so that when you click on a row Mango
will recenter the views of the brain with the crosshairs located on that point. Mango lists three types of
points for each cluster: the locations of the minimum and maximum activation values, and the centroid of
the cluster. Sometimes all three of these can occupy different brain regions. The centroid is the most
useful one for our purposes, because it corresponds to the center of mass or “middle” of the cluster. It is
the most representative point in the cluster.
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Click on rows for the different clusters, and look at the clusters in viewing window. By default, the
clusters should be listed in order from biggest (occupying the most space) to smallest in the table. A
large cluster does not necessarily mark the location of the most crucial brain activity, though.

Pay special attention to whether a given cluster occurs only in one hemisphere (left or right), or whether
it is part of a pair of clusters (one in each hemisphere, in more or less the same brain region).

Choose a most important single cluster and take a screenshot

Item 6:

Screenshot of one ROI cluster from the intersection of
both Neurosynth maps

After browsing around the brain maps and thinking for a while, decide which single cluster you think is
a good guess for “the most important brain region that is active during both of these cognitive skills.”

Take a screenshot of the Mango viewing window.
Rename the file something like “most important cluster”
Upload the file to the appropriate place on Canvas.

Explain why you chose this cluster

Item 7:

Where in the brain is this cluster, and why did you choose it?

Use the “centroid” type when you look for the name of the brain region that a cluster occupies.
Use the “Atlas 3” column to give the name of the brain region (e.g. “Precuneus” and not “Parietal
lobe”).
If the cluster is one of a pair of bilateral clusters (i.e. one in each hemisphere), then you can name
the brain region for the cluster as “bilateral X.”
You will need to explain how you made your choice. There is no clear right or wrong answer, and it
is OK if the reasons for your choice don't seem especially scientific.

For our final exercise in this assignment, look up the coordinates for your cluster in Neurosynth's
“Locations” search.

Copy the first 10 Neurosynth associations for your cluster's centroid coordinates

Item 8:
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Paste the table that lists the first 10 Neurosynth "Associations"
for this cluster's coordinates

Copy down the 3D stereotactic coordinates (X,Y,Z) for your cluster.
Repeat the instructions above (jump to that section) to view the list of the first 10 Neurosynth
associtions for those coordinates.

Copy and paste the list as your answer.

What does this brain region do?

Item 9:

What do you think this cluster's brain region does?

If (and only if) the first 10 associations returned by Neurosynth include zero cognitive skills, you may
answer “Hard to say.” In fact, it is always hard to say what a region of the brain “does.” Don't let that
stop you from making a good guess. Explain why you made your guess, even if your explanation sounds
painfully straightforward (e.g. “I guessed 'language comprehension' because that was the only cognitive
skill that appeared in the list of associations.”). Your instructor appreciates the benefits of “painfully
straightforward.”

Footnotes
1)

Both “free as in speech” and “free as in beer.” https://en.wikipedia.org/wiki/Gratis_versus_libre
2)

You might be asking yourself, “Wait, why did we have to 'scroll/click/hover' for the earlier part, then?”
Answer: Because scroll/click/hovering is good for your soul. It is easier to receive a list of brain regions
like the one in the “Point Statistics” table, but that won't help you to get an understanding of where these
regions are in the brain, what they look like, and how close they are to each other. For that, you need to
practice navigating the spatial layout of the brain.

From:
https://wiki.anthonycate.org/ - Visual Cognitive Neuroscience

Permanent link:
https://wiki.anthonycate.org/doku.php?id=teaching:writing_assignment_part_2

Last update: 2020/03/26 13:06

https://en.wikipedia.org/wiki/Gratis_versus_libre
https://wiki.anthonycate.org/
https://wiki.anthonycate.org/doku.php?id=teaching:writing_assignment_part_2

	Overview
	1. Estimated time required to complete
	2. Responses to submit on Canvas

	Get ready to neuroimage!
	1. Install Mango software
	2. Download a file to use with Mango
	3. View the structural average brain in Mango
	3.1 Start the Mango app
	3.2 Open the structural average brain file: the "image"
	3.3 Enable the atlas feature


	Get brain maps from the Neurosynth website
	1. Go to the Neurosynth homepage in your browser
	2. Get a meta-analysis for your article's topic
	2.1 Find the Neurosynth term to use for your article
	2.2 View the meta-analysis for your term
	2.3 Download the brain map image for your topic

	3. Get a meta-analysis for an "other" topic

	Explore brain map images using the Mango viewer
	1. Examine the Neurosynth brain map for your article's cognitive skill
	1.1 Find the key brain region from your article
	Potential problems with finding a brain region
	Different names for the same brain region
	I'm not a brain expert (yet)

	I HAD NO BRAIN REGION
	Is the key brain region from your article part of the Neurosynth brain map?
	Take a screenshot of the region

	1.2 What other cognitive skills are associated with this region?
	Copy down the MNI coordinates for the region
	Enter the coordinates in a Neurosynth "locations" search
	Copy the table from the "Associations" page and paste it at the bottom of your answer.
	What else might this region do?



	2. Compare the Neurosynth brain map for your "other" skill
	2.1 Add your "other" brain image as a second overlay
	2.2 Make a 3D surface model
	Take a screenshot of the 3D surface model

	2.3 Find brain regions activated by both cognitive skills
	[WHAT IF MY TWO MAPS DON'T OVERLAP?]
	Choose a most important single cluster and take a screenshot
	Explain why you chose this cluster
	Copy the first 10 Neurosynth associations for your cluster's centroid coordinates
	What does this brain region do?



	Footnotes

